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Kansas, Virginia, Louisiana, Montana, & Tennessee DOT AASHTOWare Project™
Payroll Spreadsheet Conversion Utility 2.0 Updated 5/31/23 - Revised 2/25/25

Use these instructions if your company is in Kansas, Virginia, Louisiana, Montana and Tennessee.

As most of you are aware, the DOT has teamed up with the American Association of State Highway
and Transportation Officials (AASHTO) and is now requiring ALL prime and subcontractors working on
DOT projects with federal funding to submit certified payrolls into the AASHTOWare Project Civil
Rights and Labor™ (CRL) Management System.

You can create this spreadsheet with MOST of the data filled in by Certified Payroll Solution;
however, there is NO WAY to provide this as a 100% accurate form that can be submitted due to
complicated requirements - including several drop-down menu items. You will need to check
this form carefully before submitting it.

The spreadsheet is provided by the vendor who developed the AASHTO Trns*port® system and many
aspects of it cannot be changed or modified. This form has been provided in an .XLSX format,
therefore, Office/Excel 2016, Office 365 or newer is required - and they must be locally installed on
your computer, not accessed via a web browser.

If you were given a spreadsheet by AASHTO dated AFTER 5/31/23, please contact AASHTO and ask
them for a “complete, unlocked spreadsheet” and email it to AskUs@SunburstSoftwareSolutions.com.
AASHTO does not notify us when they revise their spreadsheet.

IMPORTANT!!!!
The most important thing that you need to be aware of is that this spreadsheet CANNOT be
printed by CPS, nor will the print preview be visible to the human eye.

DO NOT call and tell us that the Preview of the report is wrong, as there is NOTHING, we can do
about this.

However, you MUST click the preview button on the Print Window in CPS to create the Excel
spreadsheet for you so that you can then open it and look at it and verify that the data is accurate
and add any missing information that is required.

AASHTO requirements are very complex and require quite a bit of setup in Certified Payroll
Solution in order to create a file that you can read, correct, and troubleshoot to upload - AND
THEN YOU WILL NEED TO TAKE THAT FILE CPS CREATED AND RUN IT THROUGH A CONVERTER to
create a machine-readable XML file - so please follow the instructions in this document
carefully. The AASHTO specific converter can be found here -
https://xml.aashtowareproject.org/spreadsheet/
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Step 1 - Existing Customers Download the program update. New Customers - start
with Step 2.

You MUST update CPS on each machine that the program is installed on.
The Version that you download will be the most current version in our Web Service Center

From the Certified Payroll Solution (CPS) Help menu = choose Check for Updates (or About - click
on the BIG “Login to Web Service Center” button).

This launches a web page and automatically logs you into our web service center. Here, look for the
Download Current CPS Setup/Installation button on the left and click on it. Run or save the file.

\sz/‘um‘.?%ﬁ =Solitions

Welcome to our Web Service Center

Certified Payroll Solution

: is the current release version available to download.

:l is the current version installed on your PC. Download the

You have installed a newer or BETA version that the current rell bl CF,)S rent release
version over a BETA/older version can cause problems. Do noft i JAUSIELELEURN - § t6 do so
by technical support.

Windows 7,8,8.1,10 users

Download Current CPS Setup / Installation (Windows 7,8,8.1,10)

Some browsers will have you save the file, while others will allow you to choose to Run

it. If you choose the Run option, simply follow the prompts, and run through the
installation program.

~
—
Can’t figure out where the download was saved?
# Press the Ctrl and the J keys at the same time on your keyboard to display a list of things you
\ ! have downloaded. This works in Internet Explorer, Chrome, and Firefox. Double-click the file
called CPSV5setup.exe and follow the prompts in the installation wizard.
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Step 2 - Create and Select a Folder in which to save the AASHTO spreadsheet file

From the CPS System Setup menu - choose System Preferences - click on the Data Locations tab

Click into the Save Report Folder field/box and press the F9 key to have the program automatically
create a folder for you - if this field is currently blank/empty.

OR use the Browse for Reports Folder to create a folder in the location of your choice.

(Press the F5 Key to verify that the folder actually exists)
% System Preferences TS

Addresses | W/Clnfo+ | Labels = Settings Data Locations

Data Path Browse for Data Path Folder

Ci\Users\Public\CPS Masters\Virginia

The "Data Path" is the folder that contains the "Data" folder where all CPS files exist.

Quick Books File Browse for QuickBooks File

The best way to set your QuickBooks file to the correct 'location' is to make the box here blank, and then have
QuickBooks open to the correct file and click the "'Test QuickBooks Connection'.

C\Users\Public\gbMaster files\Virginia. QBW

Test QuickBooks Connection [~ QuickBooks Version is 2004 or older.

Save Reports Folder Browse for Reports Folder

Click here & press the F9 key to have one automatically created for you

Electronic Upload Folder Browse for Electronic Upload Folder

Cancel

Initial Release - 8/11/2015/Last Updated 2/25/25
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Step 3 - Turn on AASHTO DOT Filing

From the System Setup menu - choose Defaults - Job - click on the Form Option tab - click on
the Turn on AASHTO DOT Filing button

This step is ONLY
Standard || available in Virginia,
Louisiana & Montana.

|| On the Certified Payroll Report SSN Format Omit Employee Address

WH-347 Fom ook 1234 ] P It’s not required in

Tennessee.

WH 347 Options I ( Turn on AASHTO DOT Filing* )
7[5

On Electronic Filing SSN Format Omit Employee Address
Standard XML Export file. (Elation & TRS) ISh°W SSN LI I
LCP Tracker Export file. [Show SSN Z| r
Sandia Laboratory XML Export file. IShow SSN LI I~

Set ALL existing Jobs to these defaults. ’ Preview Report |

x| = @

You’ll get a small pop-up window asking if you are sure that you wish to turn on AASHTO DOT
Reporting. Click the Yes button.

[ Certified Payroll Soluﬁol From the Run menu = choose Exit.

_ e Now start CPS again by double-clicking on your
Are you sure you wish to turn on AASHTO DOT Reporting? desktop shortcut.

This option may not be turned off once it is on, so
do not use this option unless you truly need it.
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Step 4 - Setup Fringe Benefits & Special Withholdings

AASHTO expects to see the hourly rate (value) of 6 specific fringe benefit types which are already
set up in CPS, access them from System Setup menu 2> Fringe Benefits & Special Withholdings:
e Health & Welfare
Vacation/Holiday
Apprentice Fund
Pension
Other 1
Other 2

These fringes can be paid to the Union Hall, into one or more bona-fide plans, or company paid
items that you are taking credit for against the full fringe benefit amount.

Information about these fringe benefit types, and these hourly rates/values will need to be entered
into CPS for both the AASHTO and the NEW WH-347 form, because we cannot get hourly values from
QuickBooks only Weekly totals.

IF YOU PAY FRINGE BENEFITS IN CASH TO THE EMPLOYEE AS PART OF THEIR HOURLY RATE OF
PAY YOU CAN SKIP THE FRINGE BENEFITS & SPECIAL WITHHOLDINGS SET-UP AND PROCEED TO
STEP 6. YOU WILL NEED TO ENTER THE FULL CASH BENEFIT RATE FOR EACH PAYROLL WAGE

ITEM UNDER LINKED DATA > WAGES.

IMPORTANT NOTE FOR ALL STATES REQUIRING SALARIED HOURS TO BE REPORTED - TIMESHEETS
MUST BE CREATED IN QUICKBOOKS FOR SALARIED EMPLOYEES.

Important notes & information about fringe benefit setup.

. 7’ Read the following information prior to making any selections in this section. These
instructions also comply with the NEW WH-347 Form that expires in 2028 — released in January
2025.

In CPS, you can enter the Hourly Fringe Benefit Rates by:
OPTION 1 - Work Classification - NOT RECOMMENDED IN MOST CASES
Option 2 - Payroll Wage Item - RECOMMENDED IF YOU’RE UNION AND HAVE SPECIFIC
QUICKBOOKS PAYROLL WAGE ITEMS FOR EACH DIFFERENT WORK CLASSIFICATION
Option 3 - Employee - RECOMMENDED IF YOU’RE TAKING CREDITS FOR COMPANY PAID
BENEFITS AGAINST THE FULL PREVAILING WAGE FRINGE RATE AND RATES ARE DIFFERENT BY
EMPLOYEE.

Please determine HOW you are paying and tracking the fringe benefits for proper setup.

Initial Release - 8/11/2015/Last Updated 2/25/25



Sunburst Software Solutions, Inc. Page | 6

UNION CONTRACTOR - If you are a Union Contractor OR paying 100% of the full fringe benefit
rate to one or more bona-fide plans you can choose from one of the following options:

-~

-
€X Fringe Benefit & Special Withholdings Setup = (]} X

Health”welfare Vacation/Holiday Apprenticeship | Pension | Other1 | Other 2

Be careful changing names. See help for specifics.

Name: |Health/welfare
|dentified as your Health Benefit.
Paid by Employee or Employer:

(" This is deducted from the employee's paycheck and derived from QuickBooks per Linked Data --> Deductions.

I & This fringe is paid by the emplayer I

1

| This amount is derived from the QuickBooks paycheck. [NOT recommended for benefits).

I ¢ This amount is calculated by CPS I

v This contribution rate is entered for each Payroll \Wage Item. I

[ This contribution rate is entered for each Work Classification. (Not recommended)
[~ This contribution rate is entered for each Employee. (Use only when necessary.)

™ This rate reduces the cash benefit rate, if applicable (not zero).

|~ This rate reduces the total prevailng wage rate of pay.

This calculated rate reduces the Not Applicable L]

[~ The amount is actually a percent of the wage rate.

" WH-347 Pw Benefit Credit

WH-347 Type % Plan #

Reset to Default
Save & Close Cancel New 9
J

e Select This fringe is paid by the employer
This amount is calculated by Certified Payroll Solution

¢ This contribution rate entered for each payroll wage item. You must then have specific
payroll wage items in QuickBooks that you use for specific Work Classifications OR Work
Classifications and Jobs (if the fringe rate changes by job). You will then enter the hourly
fringe amounts for each type of fringe benefit by going to the Linked Data menu -> Wages
and editing each payroll wage item and enter the correct hourly fringe rate.

e Choose Union Benefit

e Click Save & Close when finished.
Go to Linked Data menu - Wages - Edit each QuickBooks Payroll Wage Item and enter
the hourly values for fringes

¢ When finished click the OK button - Done - and Yes to Save Changes.
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NON-UNION CONTRACTOR paying 100% of the full fringe benefit rate to one or more bona-fide
plans you can also choose:

£¥ Fringe Benefit & Special Withholdings Setup = O *

Health/ welfare WacationHoliday Apprenticeship Penzion | Other1 | Other 2

Be careful changing names. See help for specifics.
MName: |HealthAwelfare
Identified &g your Health Benefit.

Paid by Employes or Employer:

(" Thiz iz deducted from the employee's pavcheck and denved from QuickBooks per Linked Data > Deductions.

I * Thisz fringe is paid by the employer I

7 Thiz amount iz derived from the QuickBooks paycheck. (NOT recommended for benefits].

f* Thiz amount iz calculated by CPS

[ This contribution rate is entered for each Payroll W age Item.

I [v Thiz contibution rate iz entered for each “Work Classification. (Mot recommended) I

[ Thiz contribution rate i entered for each Employee. (Uze only when necezzam. ]

[ Thiz rate reduces the cash benefit rate, if applicable [hot zera).

[ This rate reduces the total prevvailng wage rate of pay.

Thiz calculated rate reduces the Mot Applicable ﬂ

[~ The amount is actually a percent of the wage rate,

(" Union Benefit (¢ WH-347 P Benefit Credit
o O Unlunded
WwH-347 Type Health Inz & Plan # |BD"BS Wi, 112-651]

Reset to Default
Save b Close Cancel Mew 9
)|

Select This fringe is paid by the employer

This amount is calculated by Certified Payroll Solution

This contribution rate is entered for each Work Classification (Not recommended).
This method will work if you DO NOT have specific payroll wage items in QuickBooks that
you use for specific work classification and jobs. You will then enter the hourly fringe
amounts for each type of fringe benefit by going to the Basic Info menu - selecting Work
Classifications - edit each Work Classification and enter the hourly values in the Benefits
tab. This method is NOT recommended because employees can be the same
classification on multiple jobs with each job having a different fringe rate. It’s best if
you set up specific payroll wage items in QuickBooks for each work classification/job
combination and enter fringe rates that way.

WH-347 PW Benefit Credit - because you aren’t a Union shop

Funded -because you are paying this into a bona fide plan

WH347 Type - Health Insurance

Plan # - enter the health insurance plan number.
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Click Save & Close when finished

e Go to Basic Info menu = Work Classifications = Edit each work classification that your
employees fall under and click on the Benefits tab - enter the hourly fringe benefits for
each work classification.

¢ When finished, click OK, Done, Yes to save changes

NON-UNION CONTRACTOR AND PAY A PORTION OF THE TOTAL HOURLY FRINGE RATE TO ONE
OR MORE BONA FIDE PLAND AND THE REMAINDER IN CASH TO THE EMPLOYEE.

— _

@ Fringe Benefit & Spedal Withholdings Setup = O

Health " elfare Yacation/Holiday | Apprenticeship | Pension | Other1 | Other2

Be careful changing names. See help for specifics.

Mame: |HealthAwelare
|dentified az vour Health Bersfit,
Paid by Emplavee or Employer: -

™ Thiz iz deducted frorm the employes's paycheck and derived from QuickBooks per Linked Diata -+ Deductions.

{* This fringe iz paid by the employer I

e Thiz amaunt iz derived from the QuickBooks papcheck. [NOT reconmmended for benefits).

£+ This amourt is calculated by CPS I

[ This contribution rate iz entered for each Faproll wage kem.

[ Thig contribution rate is entered for each \Work: Claszification. [Mot recommended)

¥ This contribution rate is entered for each Emploves. [Uze only when neceszsan.]

v This rate reduces the cash benefit rate. if applicable [hot zero].

[ Thiz rate reduces the tatal prevailng wage rate of pag.

Thiz calculated rate reduces the Mot Applicable LJ

[ The amount iz actually a percent of the wage rate.

(™ Union Benefit & wWH-347 P Benefit Cradit
& Funded ar ™ Unfunded
'wH-347 Type Health Insurance &Plan# jva-BSAS GERE-0A7 I

Fezet to Default
Save & Close Cancel Mew 9

This fringe is paid by the employer

This amount is calculated by CPS

This contribution rate is entered for each employee
This rate reduces the cash fringe benefit rate
WH-347 PW Benefit Credit
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¢ Funded (because you’re paying this money to the health insurance company). Otherwise
UNFUNDED if it’s vacation/holiday that you’ll ultimately be paying to the employee at some
point during the year.

WH-347 Type = Health Insurance

Enter the Plan #

Click Save & Close when you’re finished.

Go to Linked Data - Employees -> Edit each employee and enter their hourly credits.
When finished = click OK, Done, and Yes to Save Changes.

Go to Linked Data > Wages = Edit each QuickBooks Payroll Wage Item and enter the TOTAL
Fringe benefit rate in the CASH Benefit Rate block.

¢ When finished = Click Ok, Done, and Yes to save Changes.

Make your selection for each specific Fringe benefit type here AND then go
to the appropriate place to enter the hourly fringe amounts.

Step 5 - Setting Up Benefit Information

The AASHTO form wants specifics about the fringe benefits you’re paying/taking credit for, such as
Benefit Program Name, Benefit Program Type, Benefit Account Number, Benefit Program
Classification, Contact Person and Contact Person’s Phone. [f you need additional information, you
will need to contact DOT as we cannot help you.

To enter this information in CPS, go to the System Setup menu - Statement of Compliance - click
on the DOT 4 (d) tab.

Here you will enter the plan administrator (example for health insurance you would enter the name
of the insurance company - Blue Cross/Blue Shield) in the Program Title/Name column and enter an
“x” in the type of fringe it is (Health).

r -
B s o contoce 5 A

WH-348(1) | WH-348(4) [ DOT 4(d) | DOT 4(e)

...............................

AASHTO DOT 4 (d)
Program Title/Name Health Vacation Training Pension Other Other 2
Blue Cross/Blue Shield %
T. Rowe Price %
Local Bank ®
SUB Plan ®
Apprenticeship Bureaa %
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Click on the DOT 4 (e) tab and enter the Name, Address/Program Name, Account #, 3rd Party
Trustee/Contact, and phone number for each fringe plan.

WH-348(1) | WH-348(4) | DOT 4(d)

AASHTO DOT 4 (g)

Name, Address/Program Name Account # 3rd Party Trustee/Contact | Phone

Blue Cross/Blue Shield, Address, City, V& 12345 123 Contact 888-222-333
T. Rowe Price, Address, City, VA 12345 456 Contact 888-333-444
Local Bank, Address, City, V& 12345 789 Contact 888-444.555
U. S. Bank Trustees, Address, City, VA 12345 012 Contact 888-555-666
Apprenticeship Bureau, Address, City, V& 12345 | 3456 Contact 888-666-777

Click the Ok button when you have completed this information.

Step 6 - Setup AASHTO Ethnicity, Craft & Labor Codes in CPS

AASHTO & each State’s DOT have agreed upon specific Ethnicity (Race), Craft Codes and Labor
Codes. These codes are likely to be different than those that we’ve included in the following
examples.

Kansas - Download the “Excel Template” found on this page -
https://www.ksdot.gov/home/showpublisheddocument/1839/638736655784170000

Virginia - Download the “Excel Template” found on this page -
https://www.virginiadot.org/business/aashtoware_project_civil_rights_and_labor_crl_management
system.asp your Ethnicity, Craft & Labor Codes are included in the Excel template

Louisiana - Download the DOTD_Payrollv2.0_2.15.19 found on this page -
http://wwwsp.dotd.la.gov/Inside_LaDOTD/Divisions/Administration/Compliance/Pages/Certified_Pa
yroll.aspx Your Ethnicity, Craft & Labor Codes are included in this file

Montana - Download your Ethnicity, Craft, & Labor Codes here -
https://mdt.mt.gov/publications/docs/brochures/dbe_eeo/Certified-Payroll-Codes.pdf Your
Ethnicity, Craft & Labor Codes are NOT included in your spreadsheet.

Tennessee - Download the Excel Spreadsheet v1.6 (Current) file to find your Ethnicity, Craft & Labor
Codes here - https://www.tn.gov/tdot/tdot-construction-division/transportation-construction-
division-resources/tdot-labor-compliance/certified-payrolls.html
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Ethnicity/Race Values

View and verify that you have the required Ethnicity (Race) Values in CPS, by going to the Basic Info
menu > choosing Race Classifications. These items must be set up exactly as they are in the
AASHTO payroll spreadsheet - Ethnicity tab.

To add or modify the Race Values, in CPS go to the Basic Info menu - choose Race Classifications.
To add a new Race Classification, click the Add button otherwise click the Edit button to modify an
existing classification.

In the following example we will add a Race classification for NON-MINORITY WOMEN. Again,
remember to enter the names from AASHTO in the EXACT format that they are shown - including all
upper case letters it that is the way they are displayed..

Description ON-MINORITY WOMEN

Race [white: ~|

Pacific Islander

White [~ Minority

|~ Native Hawaiian or Other Pacific Islander
[~ Two Or More Races

Cancel ’

An ASIAN/PACIFIC ISLANDER would be setup as shown below:
€% Race Classification Mainnmm_@lm

Alaskian

American Indian Description ASIAN/PACIFIC ISLANDER

Race |Asian/Pacific Islander ~|

v Minority
|~ Native Hawaiian or Other Pacific Islander

[V Two Or More Races

" American Indian or Native Alaskan & White

" Asian & White
" American Indian or Native Alaskan & Black or African American

" Other Mixed Race
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Craft & Labor Codes

To enter the Craft & Labor codes into CPS, go to the Basic Info menu - choose Work Classifications.
Here you will either Edit existing Work Classifications that you have previously created OR add new
ones based on AASHTO requirements. Click on the Electronic Upload Codes tab.

These work classifications MUST be created in CPS EXACTLY as they are shown in the AASHTO
spreadsheet - including the use of all CAPS and some things in parenthesis.

Here is an example: Let’s say your company has workers that fall under the Truck Driver-Single Rear
Axle classification.

The AASHTO Craft Code is TRUCK DRIVER
The AASHTO Labor Code is TRUCK DRIVER (SINGLE REAR AXLE)

If you choose to enter Fringe Benefits by Work Class, enter the hourly rates for applicable fringes
under the Benefits tab.

%8 Work Class Maintenance — [m] *

i | Carpenters Mame |TRUCK. DRIVER [SINGLE RE&R &xLE)

| |Cement Masons

Clerical

Deferto Employee Federal EEOC Cods |Truck Drivers |
| Elt?u?pn.c[l_ijnesrs. Usze This Hame on EEOC Reports [

Fareperson

Fareperson apprentice §0%
Iromworkers

| |Laborer, Semi Skilled OTJT
Laborer, Semi-Skilled Apprentice - Percent i Level

| |Lakorer, Unskilled et & 04 - US Office of Apprenticeship

| [Laborer-Apprentice 50% : ™ S48 - State Apprenticeship Agency

Laborer-Apprentice 8024
| {Mechanics

| | Mewver Report

| |Officials (Managers)

| |Fainters

| |Fipefiter Plurmber

| SUEENiSDrS On the Certified Paproll Report I Electronic Upload Codes I
| Texasz DOT Job Class i T DOT Appr Experience i

WY DOT EBO Classification Code
Maryland Classification ID [Job Code 1D]

On the Job Trainee | | Owner Operator N

Program Mame |

AASHTO Craft Code |TRUCK DRIVERS
AASHTO Labor Code [TRUCK DRIVER (SINGLE REAR AXLE)

Prizm Craft |

Prism Craft Level |

LEPtracker Craft Code |

(o]’ Cancel 9
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NOTES ABOUT AASHTO CRAFT & LABOR CODES:
o Tennessee simply wants the CODE NUMBERS without the “Craft” or “Labor” values/names.
¢ Virginia wants the Labor and Craft Values - no codes

M If you create new Work Classifications remember that you will need to assign them to
Employees (Linked Data > Employees) and QuickBooks Payroll Wage Items (Linked Data
Wl > Wages).

Step 7 Selecting Jobs that require AASHTO reporting

In CPS, go to the Linked Data menu - Jobs, edit each job that requires AASHTO reporting:
= On the Additional Info tab enter The Serial/AASHTO Project #

- click on the Form Options tab and make sure that the Use WH-347 Form instead of AASHTO
DOT form is NOT checked if you need to create the AASHTO form. If you need the WH-347 form, you
do have the option to print either the NEW WH-347 form (Expires 2028) or the OLD WH-347 (expires
2026)

A = = £ Job Maintenance - [m]
Shomoa e S [Crange v Change Orders Hame |Change Oiders
e | ety | mrmiiss siandsis Infemian SR S addiendinfamalion. S I Eem: etore
Certified Payroll Report Lsave thi ti I.LEUWEU Eovioll Bpoar, Prints the NEW WH-347
I~ Use WH347 Fediral Fom instead of ABGHTO DT Fam u:; jz#':d ?Erlgi fel Use w347 Federal Fom ateod o ASSHTO BOT fam i T (Expires zvu_éalm

AASHTO Form [ Use Depariment of Defense Statement of Compliance
™ Use Depatment of Defense Statement of Compliance S s el e e e
™ Use Notarized Fereral Statemert of Compliance P

If ts fold fied, do nat physicalky print this form (CPR & SOC), just save it
™ If a save repors folder is specified, do not physically print this form (CPR & S0C), just save it e el

S5 # Fomat A1 234 - SN # Format

: [ Owit Emploee’s address I~ Piint Check #
i Omit Emple wldl
] S [~ Print Emplayee Gender [~ Print Emplayee Race

[~ PrintJob Totals ot therloh Total Hoyrs
¥ Use OldWH-347 form

[~ Piint Page & of Print OLD WH-347
e (Expires 2026)
Electronic Filing Electronic Filing

Elechonic Upload Type — [Fiane = Electionic Upload Tvoe — [None ~]
55N #f Format [ronssH = SSN # Fomat Show SSN e
[™ Dmit Emplayee's address. I~ Oriit Employee’s address.
[ List By "Print Hame As" ok ) ﬂ : List By "Print Name 45" ok Bl ﬂ

=

Step 8 TENNESSEE ONLY Employee Birth Date MMYY Format

Tennessee DOT requires that the Employee Birth date is included in the upload. It must be entered
& displayed in MMYY format. This information will be added to each employee record in CPS, by
going to the Linked Data menu - Employees - and Edit each employee and entering this
information in the field called Birth Date MMYY format as shown below:
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-
@Employee Maintenance On||eE)
[Backhioe. Frecerck F JENEME

Bulldozer, Benjamin J

tt::: t mE. Local |Local 61 ~| Edit Locals |

E‘:-"‘-"-"‘_':“‘— Ow / —L— | EEOC Work Class IEquipA Opers. LI Edit Work Classes |

Supenvisor, sam

T”-E'j er. Tammi T Race IHispanic LI Edit Races |
Federal Allowances ’0—

Gender |Fema|e LI

Backhoe, Frederick F

Miscellaneous

[~ ARRA Hire

Employee # (not SSN) 1

Apprentice Registration #

Birth Date MMYY format 1160

NTW Econ Distressed Area |

NTW Disadvantaged | ~|

Ok Cancel | 0

Step 9 Printing & Previewing

When you get to the Completed Reconciliation window, you have several options for generating your
reports - BUT YOU WORD AND EXCEL CAN HAVE NO OPEN FILES.
o Create Reports & Uploads - selecting this option creates and saves your reports in the folders
you specified - this may take a few minutes so be PATIENT!
o Open Reports - selecting this option creates and opens ALL Reports at once - depending on
how many jobs you have this may cause Word & Excel to crash.
e Print Reports - send the reports to your printer - do not try to print the AASHTO report -
you won’t be able to read it!
e Preview CPR ONLY - allows you to preview the reports.
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L Printing Completed Reconciliation = TR

Copies for Each _Hep art

‘SetAll Copiesto: | [0 ‘Select Printer. . Microsoft Printta PDF
: M

.'Eﬂi't«galne--. |

[ Redact employee SSN & address infgueStioll on Gesified Payroll Report
I Force all printing to Legal Size_

Print Peparts |

Creste Reports & Uploads Jpen Reports. |

<< Back Preview CPR ONLY Mailing Labels
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Sunburst Software Solutions, Inc.

-

PRINT PREVIEW

é q [} Next Page

Print Page Zoom

Print Zoom Previey

Close Print

' Pre%ﬁ{

Page | 16

WHAT HAPPENS WHEN YOU TRY TO
PREVIEW THE AASHTO REPORT.

When you click the Preview CPR ONLY
button for an AASHTO job you will see
something like this.

This is the way it was designed to preview
and there is nothing we or you can do
about it.

Simply click the Close Print Preview
button.

Choose Open Reports instead.

When you have finished, click the Exit
button.
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Step 10 Viewing & Troubleshooting the Report Before Uploading

From the main CPS window, choose the View menu - Saved Reports

Run Linked Data BasicInfo Backup and Restore System Setup |View| Help

Using: Virginia Certified Payroll for QuickBooks{V4) Saved Reports

This will automatically open the folder that you created in Step 2.

=l S |

v Search Reports po

» Computer » OS(C:) » Users » Public » CPSMasters » Virginia » Reports

sw Tools Help

Include in library v Share with v Burn New folder =~ 0 @
= Name i Date modified Type Size |
- £ CPR-Crew Entry-2009-02-28.xlsx 8/11/201510:32 AM  Microsoft Excel W... 776 KB
Backup Plus Drive (E

Here you can double click on the file to open it in Excel (IN A FORMAT THAT YOU CAN READ) to verify
it for accuracy.

ONCE YOU HAVE VERIFIED THAT THE INFORMATION IS CORRECT YOU WILL NEED TO TAKE THE
EXCEL FILE AND CONVERT IT INTO THE XML FORMAT THAT THE AASHTO SYSTEM CAN READ!
The converter can be found here - https://xml.aashtowareproject.org/spreadsheet/

Once you have opened this web page - follow the Contractor Instructions indicated below in the
screenshot:
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Contractor Instructions
= Please contact your agency to request a copy of their customized Payroll Spreadsheet.
= Completed Payroll spreadsheets can be used with the Conversion Utility below.

= If you experience issues with using the AASHTOWare Project Spreadsheet and Conversion Utility, please contact your agency's representative.

Converter
Once you have a payroll spreadsheet with your data entered, you can create a Payroll XML file online with this tool.

Instructions:
= Use the following form to select the spreadsheet you have created, Check the box agreeing to the Terms of Use, then click the Convert button to send your

spreadsheet to the online conve@“y-
L3y
Browse... e selected. ] | agree to the Terms of Use | Convert

= Save the Payroll XML file that is returned from the online converter.

You can now deliver the Payroll XML file to the agency via whatever method they have established.

Use the BROWSE button, navigate to and select the Excel file you verified.

Click the “I agree to the Terms of Use” option

Click Convert

Once it’s converted, save the NEW XML file back to your hard drive in the same location.

Log into the DOT website and select the xml file to upload the report.

We’ve provided some samples so that you can troubleshoot for accuracy and or missing information,

so that you can go back, make corrections, and then rerun the reports before you upload.

NOTE: WHILE THE SAMPLES SHOWN DISPLAY VIRGINIA DEPARTMENT OF TRANSPORTATION - THIS
DOCUMENTATION IS FOR VIRGINIA, LOUISIANA, MONTANA & TENNESSEE.
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- ™ = .1
AASHTOWare U_‘O_mnﬁ _um<_‘0__ .wU_‘mmn_memﬂ Conversion C.n___ﬁ< 1.03.002.00 PLEASE READ THESE TERMS OF USE CAREFULLY BEFORE CONTINUING YOUR USE OF THIS SPREADSHEET. IF YOU USE THIS
SPREADSHEET YOU ACCEPT AND AGREE TO ALL OF THE TERMS AND CONDITIONS CONTAINED IN THESE TERMS. IF YOU DO

NOT AGREE WITH THESE TERMS AND CONDITIONS, DO NOT USE THIS SPREADSHEET.
U D _ USE OF THIS SPREADSHEET IS AT YOUR SOLE RISK, AND AASHTO ACCEPTS NO RESPONSIBILITY FOR THE RESULTS RETURNED.
Instructions Y Virginia Department of Transportation Copyright © 2014 AASHTO

1: The blue fields are available for data entry.

2: Click the field names for a description.

3: Use 'Save As' in Excel to save file. Note the name and the location where you are saving.
4. Upload the spreadsheet/XML file using prescribed Agency method.
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CONTRACTOR | SUBCONTRACTOR 3| CONTRACTOR ADDRESS
Addr 1[2378 Dane Hill Road @E ) WHERE FRINGE BENEFITS ARE PAID TO APPROVED PLANS, FUNDS, OR PROGRAMS
Name of Contractor  |Virginia Certified Payroll for QuickBooks Addr 2/ In addition to the basic hourly wage rates paid to each laborer or mechanic listed in the above referenced payroll, payments
Contractor's ID  |987654321 e City|West Charleston _ State: |VA of fringe benfits as listed in the contract have been or will be made to appropriate programs for the benefit of such
Payoli Number 1 M Zip:  [se2 employees, except as noted in section 4(c) below.
o~ -
For Week Ending  [2/28/2009 Contract #[123456 VA-123456 @ | (b) WHERE FRINGE BENEFITS ARE PAID IN CASH
Each laborer or mechanic listed in the above referenced payroll has been paid, as indicated on the payroll, an amount not
Day _ Sunday _ Monday _ Tuesday _EmnammnmL Thursday _ Friday _ Saturday _ less than the sum of the applicable basic hourly wage rate plus the amount fo the required fringe benefits as listed in the
Date | 2/22/2009 | 2/23/2009 | 2/22/2009 | 2/25/2009 | 2/26/2009 | 2/27/2009 | 2/28/2009 | contract, except as noted in section 4{c) below.
Once you select a "Benefit Program Type", you must complete the corresponding column information for the system to accept the benefit.
Benefit Program Name Benefit Program Type Benefit Account Number Benefit Program Classification Contact Person Contact Person's Phone
Blue Cross/Blue Shield, Address, City, VA 12345 Fringe Health/Welfare 123 Blue Cross/Blue Shield Contact 8882223333
a‘_ T. Rowe Price, Address, City, VA 12345 Fringe Pension 456 T. Rowe Price Contact 8883334444
Local Bank, Address, City, VA 12345 Fringe Vacation/Holiday 789 Local Bank Contact 8884445555
U. S. Bank Trustees, Address, City, VA 12345 Fringe Other 1 012 SUB Plan Contact 8885556666
Apprenticeship Bureau, Address, City, VA 12345 Fringe Apprenticeship Fund 3456 Apprenticeship Bureaa Contact 8886667777
Select Type

Sunburst Software Solutions, Inc.

1. Contractor’ s ID - this comes from CPS by going to the System Setup menu - choosing System Preferences > Addresses tab
- Contractor’ s License # field. If this is currently empty, enter this information and it will automatically populate on NEW
jobs. Existing Jobs will require that you also go to Linked Data - Jobs - edit each job, going to the Additional Information
tab and entering it into the License field.

2. Contract # - this comes from CPS by going to the Linked Data menu - Jobs = Edit each job and enter values into the
Federal Project #, State Project Number fields or both.

3. How Fringes are paid, Plan or Cash - this comes from CPS by going to the System Setup menu - Statement of Compliance
- click on the WH-348 (4) tab. If these boxes are not currently checked, set your preferences now and it will automatically
populate on NEW jobs - be sure to also select the Use this information as a default for each job. Existing jobs will require
that you also go to Linked Data - Jobs - Edit each job = click on the Statement of Compliance Optional Fields button and
make your selection there.

4. Benefit Program Information - See Step 5 in this document for setup instructions.
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0T. Total  RATEOF

Individual Employee Name and Identifier or HOURS WORKED EACH DAY Hour PAY Payroll Deductions
sT. e
Last Name |Trucker
FirstName [Tammi z or. [ 000 [ o000 [ o000 [ o000 [ o000 [ 000 [ 000 ][ 000 |] | [_Employee Comments
- . roject #
= =
Middle Initial st ] o000 | so0 [ so0 [ soo [ so0 [ 800 | o000 | (2000 ] [(2200
ssh ]
Faaiil CraftCode  TRUCK DRIVERS i i E
@ oT% Apprentice Apprentice Lump Sum nho_m t
Vendor Emp ID LaborCode  TRUCK DRIVER (SINGLE REAR AXLE) D Wage % Gross
Gender [Female Il 5 [ ss00 [l | | | [ 8s80.00
Ethnicity A-PF___IAN/PACIFIC ISLANT e\ J)
Addelined = Federal = i o NET
Gross Pay FICA Optional 1 Optional 2 Deduction Deduction
Addelinal Income Tax . B WAGES
Ciy [88000 [ 5456 | 10200 | 1173 | 1276 | 968 | 19073 | [689.27 |
State Select State Code Fringe Benefit Rates
00000 Health A Fringe
e SM_ma,E M_mh_m.wmg uwﬂﬁ_nm Pension Other 1 Other 2 Benefits
Has Changed? TRUE e e Total
Salaried (y/n) : No J2[ 100 [ 200 [ o010 [ 300 [ o010 [ o000 | [[20000 ]
4{c) EXCEPTION (CRAFT) Other Deductions
Other Deduction Description Amount
Child Support 0.00
Union Dues 0.00
Medical 0.00
Garnishments 9.68

1. Ethnicity - this comes from the CPS Basic Info menu - Race Classifications. If Race classifications are incorrect -
please see Step 8 of this document.

2. Craft & Labor Code Descriptions - this information comes from the CPS Basic Info menu - Work Classifications. If
Work Classifications are not displaying properly - please see Step 6 of this document.

3. Craft & Labor Code Numbers - if your Craft & Labor Code Descriptions are accurate these values will automatically
populate. If you do not see these numbers, then you do not have your CPS Work Classifications setup correctly - see
Step 6 of this document.

4. Hourly Fringe Benefit Rates and Fringe Benefit Totals - these hourly values come from information that you
entered into CPS when you followed Step 4 in this document. If this information is not correct, you will need to
address your setup for Step 4.
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